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Vorwort 

Die Universitätsbibliothek Heidelberg bietet schon seit mehreren 
Jahren Kurse zu Literaturverwaltungsprogrammen an. Ein Grund 
hierfür ist, dass diese Programme das steigende elektronische 
Informationsangebot der Bibliotheken in idealer Weise ergänzen. Sie 
bieten umfangreiche Möglichkeiten, recherchierte Informationen auf 
einfache Weise in eine individuelle Informationssammlung zu 
importieren, zu ergänzen und in wissenschaftliche Textdokumente 
zu integrieren. Damit wird die Erstellung von Examens- und 
Hausarbeiten, aber auch die Publikation von Forschungsergebnissen 
beträchtlich erleichtert.  

Die besonders leistungsfähigen Literaturverwaltungsprogramme 
bieten neben komfortablen Rechercheschnittstellen zu 
Informationssystemen umfangreiche Sammlungen von Zitierstilen 
an, die für die Erstellung von wissenschaftlichen Texten genutzt 
werden können. Mit einem Mausklick lassen sich dabei Zitate eines 
umfangreichen Dokumentes von einer historischen auf eine 
medizinische Zitierrichtlinie ändern.  

Die Universität Heidelberg, vertreten durch das 
Universitätsrechenzentrum, hat sich in diesem Jahr für einen Vertrag 
mit EndNote entschieden. Dieses seit Jahren in den anglo-
amerikanischen Ländern etablierte Literaturverwaltungsprogramm 
bietet komfortable Anbindungen an Datenbanken und 
Textverarbeitungsprogramme sowie mehrere hundert Zitierstile, die 
zusätzlich an individuelle Bedürfnisse angepasst werden können. Die 
konkreten Bezugs- und Nutzungsbedingungen von EndNote sind 
abhängig von den Lizenzverträgen, die die Institute bzw. Fakultäten 
abgeschlossen haben; Auskünfte werden dort erteilt. 

Die Universitätsbibliothek unterstützt die Einführung des 
Literaturverwaltungsprogramms mit speziellen Schulungen und der 
hier vorliegenden Kurzanleitung. Die Termine für die einzelnen 
Veranstaltungen sind auf den Schulungsseiten der 
Universitätsbibliothek (http://ub-schulung.uni-hd.de) zu finden.  

Die hier vorliegende Anleitung basiert auf der Version X3. Sie gibt 
einen Überblick über die wichtigsten Funktionen von EndNote. 
Punktuell werden die Inhalte an Beispielen erläutert. Hinweise und 
Tipps weisen auf Besonderheiten des Programms und spezifische 
Optionen des Informationsmanagements hin.  Sie sollten nach dem 
Durcharbeiten der Kurzanleitung 

• neue Literaturdatenbanken und neue Referenzen erstellen 
können, 

• Referenzen von Online-Datenbanken importieren können, 

• die Suchfunktion von EndNote verwenden können, 

• eine Bibliografie in dem gewünschten Zitierformat erstellen 
können. 

Funktion von 
Literaturverwaltungs-
programmen  

Ziele / Funktion dieser 
Anleitung 
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Da die Arbeit mit Literaturverwaltungsprogrammen wie EndNote 
eine Ergänzung zu Literaturrecherchen in Datenbanken und 
elektronischen Katalogen darstellt, sollten zumindest 
Grundkenntnisse und erste Erfahrungen in der Nutzung dieser 
Programme vorhanden sein.  

Auf die Installation von EndNote wird hier nicht näher eingegangen, 
da sich das Programm einfach über die Installations-CD – sie ist i.d.R. 
beim Institut bzw. der Fakultät erhältlich - installieren lässt. Bei der 
Nutzung von MSWord wird empfohlen, dieses Programm vor 
EndNote zu installieren. 

Neben dieser Anleitung finden Sie auf unserer Schulungsseite unter 
http://www.ub.uni-heidelberg.de/schulung/ ein umfangreiches Tutorial 
mit Screenvideos und zahlreichen Materialien zur Nutzung von 
EndNote. 

 

Bei Fragen und Anregungen wenden Sie sich an:  
 

Benno Homann  
Fachreferent, Leiter des Teaching Teams 
Tel: 06221-54-2547 
E-Mail: Homann@ub.uni-heidelberg.de 

 

Voraussetzungen und 
Installation  

Weiterführendes  
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1. Erste Schritte 
 
Hier werden die grundlegenden Kenntnisse und Fähigkeiten vermittelt, 
die für die Handhabung von EndNote erforderlich sind:  

• EndNote öffnen 
• Literaturdatenbank erstellen und öffnen 
• Referenzen öffnen, ansehen, sortieren, gruppieren und suchen. 

 
1.1. Öffnen 
 
Öffnen Sie das Programm durch Klicken auf die Verknüpfung auf 
Ihrem Desktop oder unter Start > Programme > EndNote > EndNote 
Program. 
 
Nun erscheint ein Dialogfenster, in dem Sie auswählen können, ob Sie 
eine neue Literaturdatenbank erstellen, die Sie wie gewohnt speichern 
können oder eine bereits vorhandene öffnen wollen. 
 
Wählen sie Open an existing 
library. Mittels Browse 
können Sie Ihre Datenbank 
suchen und öffnen. Die 
Dateiendung für EndNote-
Dateien lautet: enl. Für die 
Einarbeitung in EndNote 
können, Sie die mitgelieferte 
Beispieldatei 
Sample_Library.enl 
auswählen. Sie finden diese 
in dem Ordner Ihrer 
EndNote-Installation unter Examples. Klicken Sie auf OK. 
 
Nun wird das Literaturdatenbankfenster geöffnet, in dem in jeder Zeile 
eine Referenz bzw. die Kurzanzeige hierzu zu finden ist. Auf der 
linken Seite werden die Gruppen angezeigt, mit denen eine weitere 
Sortierung der Referenzen ermöglicht wird. 

 

 
 
 
 

 
In der ersten Spalte, gekennzeichnet mit fig+ , wird angezeigt, ob in 
der Referenz eine Grafik enthalten ist. Die Büroklammer in der 
zweiten Spalte enthält Hinweise, ob eine Datei, z.B. ein PDF-
Dokument, mit der Referenz verknüpft und abrufbar ist. In den darauf 
folgenden Spalten werden Autor, Erscheinungsjahr und der Titel der 
Arbeit angezeigt. 

Programm öffnen 

Literaturdatenbank 
öffnen und ansehen 

Aufbau der Datenbank 

HINWEIS: Als Referenz bzw. Referenzinformation wird hier ein 
Datensatz bezeichnet, der die Informationen zur Beschreibung 
eines real existierendes Werkes (Buch, Aufsatz etc.) enthält.  
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In den neueren Versionen von EndNote werden in weiteren Spalten 
der Titel der Zeitschrift, der Referenztyp und die URL-Adresse (falls 
online verfügbar) angezeigt. Man kann diese Spalten auch über Edit > 
Preferences > Display Fields anpassen. 
Durch Anklicken der jeweiligen Spaltenbezeichung (z.B. Author, 
Year, Title) können die Referenzen nach dem jeweiligen Kriterium 
sortiert werden. 

 
 
 
 
 
 
 

 
 
 
 

 
1.2. Suchen 
 
In dem Fenster der Literaturdatenbank finden Sie unten die Karteikarte 
Search. Wenn Sie darauf klicken, wird Ihnen der Suchdialog 
angezeigt, mit dem Sie die Datenbank durchsuchen können. Mit 
Strg+F erhalten Sie das gleiche Ergebnis. 
 
Tippen Sie in die erste Zeile einen Suchbegriff, beispielsweise extinct 
ein und wählen Sie links daneben über das Dropdown-Menü Any Field 
aus. In den nächsten beiden Zeilen geben Sie 1990 und 1999 ein. Da es 
sich hierbei um Jahreszahlen handelt, wählen Sie im Dropdown-Menü 
daneben Year als Suchkriterium aus.  
 
In der zweiten Spalte wählen Sie in der zweiten Zeile Is greater than 
or equal to und in der nächsten Zeile Is less than or equal to aus. 

Literaturdatenbank 
durchsuchen 

HINWEIS: EndNote unterscheidet nach Referenztypen, die sich 
auf den Typus des nachgewiesenen Dokuments beziehen. Die 
wichtigsten Referenztypen sind: 
• Book – Monographien 
• Edited Book – Sammelwerk mit Aufsätzen, die von einem 

Herausgeber zusammengestellt wurden 
• Book Section – Aufsatz in einem Sammelwerk 
• Journal Article – Aufsatz in einer Zeitschrift 
• Webpage – Internetseite  
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TIPP: Wenn Sie Literatur eines bestimmten Autors suchen, können 
Sie die schnelle Suche verwenden. Dazu müssen Sie lediglich einmal 
in die Tabelle klicken und dann die ersten Buchstaben des Namens 
auf der Tastatur eingeben. Das Programm springt dann an die 
passende Stelle.  

Damit können Sie Referenzen suchen, die den Suchbegriff extinct 
enthalten und in dem Zeitraum von 1990 bis1999 erschienen sind.  

 
 
 
 

Nach dem Klicken auf Search werden die gefundenen Referenzen 
angezeigt.  
 
Sie können in die Druckansicht wechseln, wenn Sie im Menü auf File 
> Print Preview gehen. Unter File > Export können Sie die Datei z.B. 
als Textdatei speichern oder unter File > Print Ihre Referenzen 
ausdrucken.  

 
 

 
 
 

 
Wenn Sie Ihre Literaturdatenbank nach Dubletten durchsuchen wollen, 
wählen Sie im Menü References > Find Duplicates aus. Es werden 
nun alle Referenzen angezeigt, die mehrfach in der Datenbank 
vorhanden sind. Gleichzeitig werden auch alle Referenzen, die jünger 
als der originale Eintrag sind, markiert und Sie können diese über 
References > Move References to Trash oder mit der 
Tastenkombination Strg+D löschen. Mit diesen Befehlen können Sie 
natürlich auch andere Referenzen löschen. 

 
 

 
 
 

1.3. Vorschau und Zitierstil 
 
Um die Vorschau einer Referenz zu bekommen, markieren Sie diese 
mit der Maus oder springen mit den Pfeiltasten auf diese.  

Referenzen exportieren 
oder ausdrucken 

Dublettensuche und 
Referenzen  aus der 
Datenbank löschen 

HINWEIS: Durch Klicken auf References > Show All References 
oder durch die Eingabe von Strg+M können Sie sich wieder die 
vollständige Literaturdatenbank anzeigen lassen. 
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Im unteren Abschnitt des Fensters erscheint dann die Kurzansicht der 
Referenz, die in dem gerade eingestellten Zitierstil, hier Annotated, 
ausgegeben wird.  
 
Das Ausgabeformat der Referenz kann geändert werden. Dazu wählen 
Sie in der Menüleiste des Datenbankfensters über das Dropdown-
Menü einen anderen Stil, z. B. Author-Date, aus.  

 

Über den Auswahlpunkt Select Another Style finden Sie weitere 
Zitierstile, wie zum Beispiel Harvard, der in vielen 
Geisteswissenschaften verwendet wird. 
 

 

 
 
 

 
1.4. Referenzen öffnen und ändern 
 
Durch Drücken von Enter oder Doppelklicken auf eine markierte 
Referenz öffnet sich ein zweites Fenster, in dem die gesamte 
Information zur Referenz einzusehen ist. Hier können Sie die Referenz 
ändern und ergänzen, indem Sie etwa weitere Schlagworte eintippen. 

Ansicht/Zitierstil ändern 

Referenzen öffnen und 
ändern 

TIPP: Informieren Sie sich, welcher Zitierstil in Ihrem Fach und 
von Ihrem Dozenten verlangt wird.  
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1.5 . Speichern 
 
Speichern Sie die Referenz durch Schließen des Fensters oder indem 
Sie im Menü auf File > Close Reference klicken. Mit der Tasten-
kombination Strg+W können Sie die Referenz ebenfalls schließen. 
 

 
 
 
 

 
1.6. Gruppen 
 
Sie können Ihre Referenzen auch in Gruppen organisieren. EndNote 
X3 bietet hierfür zwei verschiedene Möglichkeiten an.  
Mit Custom Groups können Sie Referenzen Ihrer Wahl gruppieren. 
Um Referenzen in eine Gruppe zu schieben klicken Sie mit der rechten 
Maustaste darauf. Im Menü, das nun erscheint, wählen Sie Add 
References To und die Gruppe, der diese Referenz(en) zugeordnet 
werden soll(en). 
Wenn Sie mit der rechten Maustaste auf die linke Seite des 
Datenbankfensters klicken, können Sie mit Create Group eine neue 
Gruppe anlegen.  
 
Smart Groups ermöglichen Ihnen das Anlegen von dynamischen 
Gruppen. Diese haben den Vorteil, dass sie, wenn Sie neue Referenzen 
einfügen, automatisch prüfen, ob eine Referenz einer oder mehreren 
Gruppen zugeordnet werden soll oder nicht. Eine neue Gruppe dieser 
Art können Sie im Menü über Groups > Create Smart Group anlegen. 
Die Festlegung der Zugehörigskeitskriterien zur Gruppe funktioniert 
ähnlich wie die Suche in der Datenbank. 

HINWEIS: Alle vorgenommenen Änderungen werden automatisch 
gespeichert! 

Gruppieren von 
Referenzen 

Speichern 
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2. Referenzen erstellen 
 
Von grundlegender Bedeutung für eine effiziente Nutzung von 
EndNote ist die Erweiterung oder Ergänzung der Datenbank.  
Grundsätzlich lassen sich drei Methoden zur Ergänzung einer 
EndNote-Datenbank unterscheiden, die hier vorgestellt werden: 

• Manuelle Eingabe  
• Direkter Import mit der Connect-Funktion 
• Download und Import  

 
Hier werden die Kenntnisse und Fähigkeiten vermittelt, die für die 
Ergänzung einer EndNote-Datenbank um weitere Informationen 
erforderlich sind:  

• Neue Referenzen erstellen 
• Dateien und Bilder an Referenzen anhängen 
• Referenzen importieren 
• Literaturdatenbank durchsuchen 

 
 
2.1. Manuelle Eingabe 
 
Erstellen Sie eine neue Referenz, indem Sie im Menü References > 
New Reference wählen oder Strg+N drücken. Sie können im Menü 
des eingeblendeten Fensters auch auf das Symbol mit dem grünen Plus 
klicken. Es erscheint ein neues Referenzfenster, in das Sie die 
Informationen eintippen können. EndNote weist neuen Referenzen 
automatisch den Referenztyp Journal Article zu. Über das Dropdown-
Menü Reference Type können Sie den Referenztyp ändern. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Um die Eingabe von Referenzen zu üben, können Sie folgendes 
Beispiel nutzen: 
 
Jacobson, Carol/Roe, Jennifer: Impacts of meteorites on Earth, New 
York: Blackcourt Press, 1999, 100 Seiten 

Manuelle Eingabe 

Beispiel für die Eingabe 
eines Buches 
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Abstract: The impact of meteorite hitting earth millions of years ago 
may have led to the extinction of some marine life. 
 

 
 
 
 
 

Der Referenztyp muss bei diesem Beispiel auf Book geändert werden.  
 
Während Sie den Namen in das Feld Author eintippen, wird EndNote 
Vorschläge mit ähnlichen Namen machen, um Ihnen die Arbeit etwas 
zu erleichtern. Nach Drücken von Enter wird der Name in roter Schrift 
angezeigt, da die Autorin neu in der Literaturdatenbank ist.  
Den Namen der zweiten Autorin tippen Sie, nach dem Drücken von 
Enter, in die nächste Zeile. Da er schon in der Literaturdatenbank 
vorhanden ist, kann EndNote den Namen für Sie vervollständigen. 
Drücken Sie zur Übernahme des Vorschlags auf die Tabulator-Taste. 
 
Autoren werden in der Form: Nachname, Vorname zweiter Name 
eingegeben. Der Nachname wird also mit einem Komma von den 
Vornamen abgegrenzt. 
 
Mit der Tabulator-Taste oder dem Cursor können Sie sich nun durch 
die Felder bewegen und die vorhandenen Daten in die dafür 
vorgesehenen Felder eingeben. 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
EndNote bietet umfangreiche Möglichkeiten, um neben den formalen 
Merkmalen wie Autor auch den Inhalt einer referenzierten Publikation  
zu erfassen.  

 
 
 
 
 
 
 

 

Abstract  und 
Schlagwort zur 
Erfassung des Inhalts  

HINWEIS: Achten Sie bei der Eingabe der Referenzen stets 
darauf, dass der richtige Publikationstyp ausgewählt ist. Im Anhang 
finden Sie eine Übersicht der Referenztypen. 

HINWEIS: Wenn der Urheber eine Institution ist, müssen Sie die 
korrekte Handhabung durch das Programm mit Kommata steuern: 

• Setzt sich ein Name aus mehreren Teilen zusammen, die 
auch im Literaturverzeichnis erhalten bleiben müssen, dann 
muss am Ende der Wortfolge ein Komma stehen.  
z.B. Universität Heidelberg, > Universität Heidelberg   

• Kommt im Namen ein Komma vor, das auch im 
Literaturverzeichnis erhalten sein soll, dann werden zwei 
Kommata gesetzt.   
z.B. Ruprecht-Karls Universität,, Heidelberg                       
>  Ruprecht-Karls Universität, Heidelberg  

Namen von 
Körperschaften 

TIPP: Nutzen Sie das Feld Abstract, um dort Ihre inhaltlichen 
Notizen über ein Dokument ausführlicher festzuhalten. Sie können 
dort und im Feld Notes auch Zitate mit Seitenangaben notieren. 
Wenn Sie Schlagworte vergeben möchten, dann können Sie dafür 
das Feld Keywords verwenden.  
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Als weiteres Übungsbeispiel für die manuelle Eingabe einer Referenz 
in EndNote können Sie folgende Literaturangabe eines 
Zeitschriftenaufsatzes nutzen: 
 
Rex, Tiberius: The scale and the feather—a suggested evolution, in: 
Paleontology (1995) Vol.23, Issue 9, S. 23-45 
Abstract: This article discusses the evolution of bird feathers from 
reptilian scales. 
Schlagworte: Feathers, Evolution, Birds 
 
Sie können auch ein Bild an diese Referenz anhängen.  
Gehen Sie auf das Feld Figure und im Menü auf References >  Figure 
> Attach Figure. Es erscheint ein Dialogfenster, in dem Sie das 
passende Bild suchen und einfügen können. Das Bild feather2.bmp für 
dieses Beispiel finden Sie in dem Ordner Ihrer EndNote-Installation 
unter Examples. In dem Feld darunter, Caption, geben Sie Cockatiel 

Crest Feathering ein. 
 
Wenn Sie eine Datei einfügen wollen, gehen Sie ähnlich vor, klicken 
Sie aber stattdessen auf References > File Attachments > Attach File. 

 
 

 
 
 

Durch Schließen des Eingabefensters wird die Referenz automatisch 
gespeichert. 
 
 
2.2. Direkter Import 
 
Beim direkten Import nutzen Sie 
eine normierte Schnittstelle zu 
einer Datenbank, um über die 
Suchmaske von EndNote direkt 
in der externen Datenbank zu 
recherchieren und die Daten zu 
importieren. Vergewissern Sie 
sich, dass Sie mit dem Internet 
verbunden sind. 
 
Im Menü gehen Sie auf Tools > 
Online Search. Es öffnet sich ein 
Fenster, in dem Sie die 
Datenbank durch Auswahl eines 
Connection Files bestimmen 
können. Mit Quick Search 
können Sie die von Ihnen gesuchte Datenbank schneller finden. 
 
Als Beispiel können Sie z.B. die Datenbank PubMed auswählen. 
Klicken Sie auf Choose. 

Direkter Import 

Suchen in einer externen 
Datenbank   
Beispiel PubMed 

HINWEIS: Beachten Sie, dass EndNote lediglich den Pfad zu der 
Datei speichert. Wenn Sie diese in einen anderen Ordner 
verschieben, geht der Verweis darauf in der Datenbank verloren. 

Beispiel für einen 
Zeitschriftenaufsatz 

Bild- und 
Dateianhänge 
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In dem Fenster Ihrer Datenbank werden Sie nun bemerken, dass auf 
der linken Seite, bei dem Punkt Online Search, die vorher 
ausgewählte Datenbank blau unterlegt ist. Im unteren Abschnitt des 
Fensters können Sie diese Datenbank auch durchsuchen.  

  
 
 
 
 
 
 
 
 
 
 
 

Geben Sie dazu das Stichwort fossil in die erste Zeile ein. In dem 
Dropdown-Menü daneben wählen Sie Keywords (MeSH). Nun klicken 
Sie auf Search.  
 

 
 
 

 
Es öffnet sich ein Fenster, das Sie über das Ergebnis Ihrer Suche 
informiert. Diese Suche liefert über 10000 Referenzen, die Sie in Ihre 
Literaturdatenbank einfügen könnten.  
 
Schließen Sie dieses Fenster durch 
Klicken auf Cancel und schränken 
Sie Ihre Suche weiter ein, indem 
Sie in der zweiten Suchzeile 
trilobite eintippen. Daneben 
wählen Sie Any Field aus. 
Überprüfen Sie, ob beide Zeilen 
mit dem And-Operator verknüpft sind und suchen Sie erneut.  
 
Dieses Mal liefert die Suche viel weniger Referenzen, die Sie durch 
Klicken auf OK importieren können.  
 
Die importierten Referenzen werden nun in Ihrer Datenbank 
gespeichert und zunächst gesondert angezeigt. Sie können hier die 
Referenzen anschauen und diejenigen, die Sie nicht in Ihrer Datenbank 
haben wollen, gleich löschen. Wenn Sie Strg gedrückt halten, können 
Sie mehrere Datensätze auf einmal markieren. 
 

HINWEIS: Die zweite Spalte ist bei der Suche in externen 
Datenbanken nicht änderbar. 
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2.3. Import aus HEIDI 
 
Eine weitere Möglichkeit, Daten in Ihre Literaturdatenbank 
einzufügen, ist der Import aus anderen Datenbanken, die nicht mit der 
Connect-Funktion aufrufbar sind, beispielsweise HEIDI. 
 
In HEIDI markieren Sie die gewünschten Referenzen für das 
Speichern im Exportverzeichnis, indem Sie auf das Diskettensymbol 
klicken. Wenn Sie fertig sind, wechseln Sie in das Exportverzeichnis 
durch Anklicken der Funktionslasche Merkliste.  

 
 
 

 

 

 

 
 
 
 

 
Stellen Sie, mit Hilfe des Dropdown-Menüs, das Format auf EndNote 
um und klicken Sie dann auf Speichern.  
 
Je nachdem, welche Browsereinstellungen Sie gewählt haben, werden 
Sie gefragt, mit welchem Programm Sie die Datei öffnen wollen, oder 
das Programm EndNote wird gleich geöffnet. Im ersten Fall wählen 
Sie EndNote.exe aus.  
 
Nun öffnet sich ein Fenster, in welchem Sie die Literaturdatenbank 
auswählen, in der die importierten Referenzen gespeichert werden 
sollen. Falls Sie nach einem Importfilter gefragt werden, wählen Sie 
EndNote Import aus der Liste aus. Falls in EndNote schon eine oder 
mehrere Datenbanken geöffnet sind, werden die Daten in die 
Datenbank eingefügt, die zuletzt aktiv (=im Vordergrund) war. Die 
Nachfrage nach dem Speicherort entfällt in diesem Fall. 
 
Jetzt werden in Ihrer Literaturdatenbank nur die eben importierten 
Referenzen angezeigt, die Sie an dieser Stelle noch einmal überprüfen 
und ergänzen sollten. 
 

 

 
 
 

 
Mit Strg+M können Sie wieder in die Ansicht der gesamten 
Literaturdatenbank wechseln. 
 

Import aus HEIDI 

HINWEIS: Achten Sie darauf, dass der Referenztyp korrekt 
erkannt wurde und ergänzen Sie Schlagworte und Abstracts. 



 

   

- 15 - 

 
2.4. Import aus anderen Datenbanken 
 
Der Import aus anderen 
Datenbanken funktioniert meist 
ähnlich. Manchmal müssen Sie 
dabei die Datei zunächst 
zwischenspeichern, 
beispielsweise auf Ihrem 
Desktop. Diese öffnen Sie dann 
in EndNote über File > Import. In dem folgenden Fenster wählen Sie 
dann die zu importierende Datei über den Button Choose File aus. 
Dann suchen Sie den passenden Filter unter Import Option. Sobald Sie 
auf Import klicken werden die importierten Datensätze gespeichert. 
Wenn Sie nicht wissen ob und welchen Filter Sie benötigen, lesen Sie 
das in der Hilfe der Datenbank nach. 
 

 
 
 

 
 
 

 
 
 

3. Referenzen in ein Textdokument einbinden 
Einer der wichtigsten Gründe für die Nutzung von EndNote ist die 
direkte Anbindung an MSWord und andere Programme zur 
Textverarbeitung.  
Sie erfahren in diesem Abschnitt, wie  

• das Einfügen von Referenzen 
• die Änderung des Zitierstils  

funktionieren. 
 
 
3.1 Zitate in MSWord und OpenOffice einfügen 
 
Sie wollen nun Ihre Referenzen in einem Textdokument verwenden 
und eine Bibliografie erstellen. EndNote liefert dafür das Tool Cite 
While You Write (kurz CWYW), das bei der Installation direkt in 
MSWord integriert wird. Ab der OpenOffice Version 3.x und mit 
EndNote X3 ist es auch möglich dieses Tool zu verwenden.  
 
 
 
 
 
Die gleichen Optionen, die diese Symbolleiste bietet, können Sie in 
MSWord auch unter Extras > EndNote aufrufen.  

Zitieren in MSWord 

TIPP: Sie können auf der Homepage von EndNote, 
www.endnote.com, die neuesten Filter herunterladen. Diese 
müssen Sie dann in dem Ordner der EndNote-Installation unter 
Filters speichern. Der Filter kann allerdings erst nach dem Neustart 
von EndNote gefunden werden.  
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Schreiben Sie Ihren Text wie gewohnt. Wenn Sie nun an 
einer Stelle im Text angekommen sind, an der Sie eine 
Referenz einfügen wollen, klicken Sie auf Find 
Citation(s). Das funktioniert auch bei Fußnoten. Achten Sie darauf, 
dass in EndNote die Literaturdatenbank, aus der die Referenzen 
übernommen werden sollen, geöffnet ist. 
 
Es erscheint ein Fenster, in dem Sie Ihre Literaturangaben mittels 
Stichworten, Autorennamen und dergleichen suchen können. 

 
 
 
 

Markieren Sie die gewünschten 
Referenzen und klicken Sie auf 
Insert.  
Im Text erscheint nun ein 
Platzhalter für die Referenz, der 
dann, ziemlich schnell,  
automatisch ersetzt wird.  Am 
Ende des Dokuments finden Sie 
Ihre fertige Bibliografie. Achten 
Sie darauf, dass Sie nicht in den 
grau unterlegten Feldern weiter 
schreiben. 
 
 
 
3.2. Bibliografie formatieren und einzelne Referenzen ändern 
 
Wenn Sie den Stil ändern wollen, klicken Sie auf den Button 
Format Bibliography gehen. Es erscheint ein Dialogfenster, in 
dem Sie einen anderen Ausgabestil auswählen können. Unter 
Browse finden Sie weitere Stile. 
 
Sie können einzelne Referenzen editieren, indem Sie auf Edit 
Citation(s) gehen. Es erscheint ein neues Fenster, in dem Sie 
die gewünschten Änderungen vornehmen können. Die hier 
vorgenommenen Änderungen beziehen sich nur auf die Referenz in 
Ihrem Text.  
 
Sie können hier angeben, ob 
der Autor oder das Jahr nicht 
angezeigt werden soll (Exclude 
Author, bzw. Year). Unter den 
Punkten Prefix und Suffix 
können Sie Text einfügen, der 
vor oder nach der 
Literaturangabe stehen soll, 
wie Seitenangaben und weitere 

Referenzen einfügen 

Einzelne Referenz-
einträge ändern 

HINWEIS: EndNote durchsucht hier alle Felder nach dem 
gesuchten Begriff. 
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Kommentare. 
 
Bei Pages können Sie auch die Seiten angeben, die Sie speziell in 
diesem Dokument zitieren. Das funktioniert allerdings nicht bei allen 
Zitierstilen. Mittels Insert und Remove können Sie Zitate hinzufügen 
oder entfernen.  

 
 
 
 
 
 

 
3.3. Bilder einfügen 
 
Um Bilder in Ihr Dokument einzufügen, klicken Sie zunächst 
auf Find Figure(s). Es erscheint wieder ein Suchdialog und 
Sie können Ihr Bild, nach erfolgreicher Suche, einfügen und 
wie gewohnt in MSWord formatieren. 
 
 
3.4. Zitieren in anderen Textverarbeitungsprogrammen 
 
Sie können Referenzen aus EndNote auch in andere 
Textverarbeitungsprogramme übernehmen, wenn diese es 
ermöglichen, dass Sie im RTF-Format speichern können.  
 
Für die Übernahme von Literatur markieren Sie in EndNote die 
gewünschte Referenz und klicken dann im Menü auf Edit > Copy. Sie 
können auch auf das Symbol mit den zwei übereinanderliegenden 
Blättern klicken oder Strg+C drücken.  
EndNote fügt nun in die Zwischenablage einen Platzhalter ein, den Sie 
in Ihrem Dokument mit Strg+V einfügen können. 
 
Wenn Sie fertig sind, speichern 
Sie Ihre Datei im RTF-Format 
und wechseln Sie zu EndNote. 
Gehen Sie dann auf Tools > 
Format Paper > Format Paper. 
Wählen Sie das zu formatierende 
Dokument aus und klicken Sie 
auf Öffnen.  
 
Es erscheint ein Fenster, in dem 
die gefundenen Platzhalter 
angezeigt werden. Im unteren 
Abschnitt können Sie den 
Zitierstil auswählen.  
 
Klicken Sie auf Format... Sie 

Bilder einfügen 

Zitieren mit anderen 
Textverarbeitungs-
programmen 

HINWEIS: Feste Angaben zu einem Zitat, z.B. die Angabe von 
Seitenzahlen (unter Suffix oder Pages), müssen hier vorgenommen 
werden. Da Seitenangaben in automatisch generierten 
Literaturangaben, bei einer Neuformatierung gelöscht werden. 
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werden gefragt,  wo und unter welchem Namen die Datei gespeichert 
werden soll. Nach dem Bestätigen können Sie auf Close klicken. 
Sie erhalten nun eine formatierte Kopie Ihres Originaldokumentes.  
Falls Sie an dem Dokument Änderungen vornehmen wollen, 
verwenden Sie hierfür das Original und formatieren Sie es wieder über 
EndNote. 
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4. Weiterführende Hinweise und Ansprechpartner 
 
Aktuelle Importfilter, Connection Files und Output-Styles 
(Zitierformate) finden Sie auf der Web-Seite von EndNote:  
 http://www.endnote.com/support/ensupport.asp.  
Sie müssen diese lediglich in den Ordnern Filters, Connections und 
Styles speichern. 
 
Auf der Endnote-Installations-CD befindet sich auch ein 
umfangreiches elektronisches Handbuch als PDF-Datei. Dort finden 
Sie auch Hinweise, wie man die Output-Styles ändern kann.  
 
Weitere umfassende Informationen und Tutorien finden Sie unter 
folgenden Adressen: 
- http://www.hsl.unc.edu/Services/Tutorials/ENDNOTE/intro.htm 
- http://www.library.uq.edu.au/faqs/endnote/ 
- und auf der Schulungshomepage der Universitaetsbibliothek 

Heidelberg http://www.ub.uni-heidelberg.de/schulung/ 
 
Bei Fragen wenden Sie sich an:  
 
Benno Homann  
Fachreferent, Leiter des Teaching Teams 
Tel: 06221-54-2547 
E-Mail: Homann@ub.uni-heidelberg.de 
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5. Anhang – EndNote-Referenztypen  
Über diese Referenztypen wird die Erfassung von Daten zu den 
referenzierten Dokumenten gesteuert.   
Ancient Text Werk, das von einem Autor geschrieben wurde und 

von einem Editor bearbeitet wurde. 
Artwork Kunstwerk 
Audiovisual Material Audiovisuelle Medien 

 (z.B. Film, Video, DVD, CD, Tonkassette) 
Bill Gesetzesentwurf, Gesetz 
Book Buch 
Book Section Beitrag in einem Sammelband 
Case Rechtsfall, Klage, Prozessunterlagen 
Chart or Table Grafik, Tabelle, Diagramm 
Classical Work Altsprachliches, klassisches Werk 
Computer Program Computerprogramm 
Conference Paper Einzelner Beitrag zu einer Tagung 
Conference Proceeding Tagungsberichte 
Dictionary Eintrag aus einem Wörterbuch 
Edited Book Sammelband (= von einem Hrsg. Editiertes Werk) 
Electronic Article Elektronischer Aufsatz 
Electronic Book Elektronisches Buch 
Encyclopedia Eintrag aus einer Enzyklopedie 
Equation Gleichung, Vergleich 
Figure Bild, Abbildung 
Film or Broadcast Film, Rundfunksendung 
Generic Allgemeiner Publikationstyp 
Government Document Amtsdruckschrift  (Veröffentlichungen von 

Regierungen und amtlichen Stellen) 
Grant Bewilligungsschreiben, Verleihungsschreiben 
Hearing Gerichtsvernehmung 
Journal Article Artikel in einer Fachzeitschrift 
Legal Rule or Regulation Gesetz, Verordnung 
Magazine Article Artikel in einer Zeitschrift 
Manuscript Handschrift, Druckvorlage 
Map Karte 
Newspaper Article Artikel in einer Zeitung 
Online Database Online-Datenbank 
Online Multimedia Online-Medienkombination (= Werke, die aus 

mehreren Medien bestehen, z.B. Text, Grafik, Audio, 
Video, Animation) 

Patent Patent 
Personal Communication Persönliche Mitteilung 
Report  Bericht, Rapport, Rechenschaftsbericht, Referat 
Statue Statuten, Gesetzesvorschriften 
Thesis Dissertation, Hochschulschrift 
Unpublished Work Unveröffentlichtes Werk 
Web Page Webseite 

 
 


